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  (next: Tools & TOC)
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  (next: Foreword)


  FOREWORD


  I'm not an expert in book formatting. Just somebody who likes to read books. I'm also a minimalist: less is better.


  That's why i began looking for a simple method to change sloppy or extensively formatted ebooks into clean formatted books, that don't distract while reading.


  I knew i had to do it with sigil.


  The following is the result of learning, doing, learning...


  Maybe it can help somebody else, who hasn't much time to find out for her/himself.


  Oh, before i forget, i love Ubuntu.


  Oh, before i forget, my native tongue is Dutch.


  -webe

  


  (next: About HTML)


  ABOUT HTML


  For working with sigil you need to know a minimum of HTML,


  because an epub is just a renamed zip-file of one of more html-files (and some).


  In the Book Browser at the left you see the html's, here called Sections.


  In Code View you can view the html-code of every single Section.


  What are the components of this html-code?

  


  THE HEADING: is the same for every Section of the book. Note: Leave it as it is!


  ... <?xml version="1.0"?>


  ... <!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.1//EN"


  ... "http://www.w3.org/TR/xhtml11/DTD/xhtml11.dtd">


  ... <html >


  ... <head>


  ... <title></title>


  ... </head>

  


  THE BODY: contains all the paragraphs you're going to read on your reader.


  All paragraphs stand between the tags <body> and </body>

  


  THE PARAGRAPHS


  Text is contained in paragraphs and is placed between the tags <p> and </p>

  


  That's all you need to know about html to understand what follows.


  Where are the Chapters?


  At the left, in the Book Browser, you see one or more Sections.


  The order is important: the uppermost comes first on your reader, the second comes next, etc.


  You can change this order by dragging up or down.


  The start of a new Section is also the start of a new page (page-break) on your reader!


  So, if a Section contains only one chapter, then every chapter will start on a new page on your reader.

  


  (next: My Workflow for No-Frills-Sigil-Epubs)


  My Workflow for No-Frills-Sigil-Epubs


  IN CALIBRE


  .... 1. open e-book(s)


  .... 2. convert to TXT format


  .... 3. save to disk TXT only format


  .... 4. delete book(s)


  .... 5. quit calibre


  IN SIGIL


  .... 6. open TXT file in sigil


  .... 7. save as sigil-epub


  .... 8. change to CODE VIEW


  .... 9. insert book data in meta-editor


  ... 10. clean up: remove all unwanted text and extra's


  ... 11. save


  ... 12. make chapters


  ... 13. save


  ... 14. check for errors


  ... 13. quit sigil


  IN FIREFOX


  ... 14. open in FF with EPUBReader


  ... 15. view and check


  IN CALIBRE (optional)


  ... 16. convert sigil-epub to other ebook-format

  


  (next: In calibre)


  IN CALIBRE


  Follow these instructions before you start making chapters.


  ... Open calibre


  ... Create an empty library in calibre


  ... Open the e-book(s)


  ... Convert to TXT with the default settings for TXT Output


  ... Save to disk > Save single format to disk...


  ... Choose TXT


  ... Choose directory


  ... Remove books > OK


  ... Quit calibre

  


  (next: In sigil)


  IN SIGIL


  Follow these instructions before you start making chapters.


  Open and save the TXT-file in sigil:


  ... Sigil opens in BOOK VIEW


  ... Save TXT file as a sigil-epub in the directory of your choice


  ... My choice is a directory called "sigil-epubs"


  ... I name them all as "Title (sigil)-CH.epub", where "(sigil)-CH" reminds me that they are CHapterized Sigil-epubs.


  Change to CODE VIEW


  Insert book data in meta-editor:


  ... Select the title-name (between the p-tags)


  ... Copy (Ctrl-C)


  ... Open the Meta Editor (F8)


  ... Paste (Ctrl-V)


  ... OK (Enter)


  ... Select the author-name (between the p-tags)


  ... Ctrl-C


  ... F8


  ... TAB


  ... Ctrl-V


  ... Enter


  ... Save


  Clean up:


  ... remove manually all text, that you don't want in your book (publisher's text, table of contents, etc.)


  ... remove by Find & Replace all extra's, that you don't want in your book, like


  ...... <p><br /></p> (extra blank line between paragraphs)


  ...... <p>***<p> (asterixes)


  Save


  Exit sigil

  


  (next: Making Chapters)


  MAKING CHAPTERS


  After re-opening the sigil-epub, there is only one Section in the Book Browser, the complete undivided text of the book.


  Sigil opens in BOOK VIEW, so you can now easily see how the chapters in this book are defined.


  



  The various chapter DEFinitions i have encountered sofar:


  



  DEF1 - 1, 2, 3, 4, 5, ...



  DEF2 - Chapter 1, Chapter 2, Chapter 3, Chapter 4, Chapter 5, ...


  DEF3 - CHAPTER 1, CHAPTER 2, CHAPTER 3, CHAPTER 4, CHAPTER 5, ...


  DEF4 - One, Two, Three, Four, Five, ...


  DEF5 - ONE, TWO, THREE, FOUR, FIVE, ...


  DEF6 - I, II, III, IV, V, ...


  DEF7 - Small images


  DEF8 - Description


  



  In the next chapters I will explain my methods of chapterizing books with a specific DEF.

  


  (next: DEF1)


  DEF1


  



  In BOOK VIEW: 1, 2, 3 ...


  In CODE VIEW: <p>1</p>, <p>2</p>, <p>3</p>, ...


  



  Three methods to make chapters:


  



  1.


  In BOOK VIEW


  Put your cursor behind the last sentence of what's gonna be your start-page.


  Choose: Insert > Chapter Break. I find it easier to use the shortcut keys: Ctrl+Return.


  Result: your first chapter.


  You are now in the rest of the epub. At the top stands: 1


  Use the PageDown-key to go through the text, till you see the number 2


  Repeat the above actions untill you have reached the end of the file.


  Note: at the end of the file, now the last chapter, i look again for text i don't want in my book. And remove it.


  



  2.


  In CODE VIEW


  Put your cursor behind the closing p-tag (</p>) of the last paragraph of what's gonna be your start-page.


  Make a chapter-break with Ctrl+Return.


  Then, open the Find & Replace Dialog with Edit > Find, or simply with Ctrl+F


  Type after Find what: <p>?</p>


  The question mark is the wildcard for one character, in this example you will find:


  <p>1</p>, <p>2</p>, <p>3</p> ... <p>9</p>


  Watch it! Everytime you use the Find & Replace Dialog check the correct 'Search Mode.'


  In this example it must be 'Wildcard'.


  Click on the Find Next button, and <p>2</p> appears, clothed in green.


  Put your cursor behind the closing p-tag (</p>) of the last paragraph of chapter 1, and make a chapter-break with Ctrl+Return.


  And so on, till you get the message "The search term cannot be found."


  Add an extra question mark in the search term, like this <p>??</p>, and hit Find Next - there is the begin of chapter 10!


  



  3.


  In CODE VIEW


  Replace all numbers by a so-called SGF Chapter Marker


  This one works very fast.


  Open the Find & Replace Dialog with Ctrl+H


  Put the Search Mode in Wildcard mode


  Type after Find what: <p>?</p>


  Type after Replace with: <hr class="sigilChapterBreak" />


  Hit the Replace All button


  Do the same for <p>??</p>


  Hit F6 (Tools > Split On SGF Chapter Markers)


  The complete TXT-file is now splitted in chapters.


  



  BUT, the chapters have no numbers. Well, that's easy done.


  Close sigil and re-open the epub. Why?


  All new opened chapters will be in BOOK VIEW, and that is what we'll need


  Open the first chapter by Double-Clicking the correct Section


  Put your cursor in front of the first sentence


  Type 1 and hit Return


  Double Click the next Section (the second chapter)


  Type 2 and hit Return


  And so on

  


  (next: DEF2&3)


  DEF2 & DEF3


  



  In BOOK VIEW: Chapter 1, Chapter 2, Chapter 3, ...


  In CODE VIEW: <p>Chapter 1</p>, <p>Chapter 2</p>, <p>Chapter 3</p>, ...


  or


  In BOOK VIEW: CHAPTER 1, CHAPTER 2, CHAPTER 3, ...


  In CODE VIEW: <p>CHAPTER 1</p>, <p>CHAPTER 2</p>, <p>CHAPTER 3</p>, ...



  



  In CODE VIEW


  We'll split the Section in chapters by placing a Sigil Chapter Marker before the finds of 'Chapter' (or 'CHAPTER')


  Open the Find & Replace Dialog


  Find what: <p>Chapter


  Replace with: <hr class="sigilChapterBreak" /><p>Chapter


  or


  Find what: <p>CHAPTER


  Replace with: <hr class="sigilChapterBreak" /><p>CHAPTER


  Search mode: Normal


  Hit Replace All


  F6


  The Section is splitted in Sections, which are now also chapters with the same DEF


  note: the Sigil Chapter Markers disappear after F6

  


  (next: DEF4)


  DEF4


  



  In BOOK VIEW: ONE, TWO, THREE, ...


  In CODE VIEW: <p>ONE</p>, <p>TWO</p>, <p>THREE</p>, ...



  



  In this method we're gonna use the Regular Expression mode.


  In some cases the Normal and Wildcard modes won't work. So, we have to try it, don't we?


  Ever been at the eye-doctor's? "Will you please read the following..."


  Regular Expression mode is like that for me.


  With a Regular Expression you give sigil a command to start reading from the upper-left in your file and check for a match.


  Found a match? Yes !, stop and show me. No match? continue scanning to the right. Found a match? Yes!, stop and show me. Continue please. No match? go on.... Still no match at the end? Continue at the start of the next line. And so on untill sigil has found and showed all matches.


  The Regular Expression aka command we give sigil here is:



  Find <p>[A-Z]*</p>



  Find a '<', AND find a 'p' next and behind it AND find a '>' AND find 'any uppercase character from A to Z' AND find 'one or more characters' behind it AND find a '<' AND find a 'p' AND find a '>'


  Sigil will stop at <p>ONE</p> ... first match found!


  After a Ctrl+H, i let sigil continue scanning my epub.


  The next match it finds and where it again stops searching is: <p>TWO</p>


  I hope this makes any sense to you, and is more or less acceptable for the RE-guru's.



  



  Note: you can always follow the visual method of searching in BOOK VIEW.


  Where that will bring you? "Will you please read the following...". Yes, there!


  



  In CODE VIEW



  Search for all occurrences of these chapter-names:


  Find what: <p>[A-Z]*</p>


  Regular Expression mode


  Hit the Find Next button


  Make a Chapter Break with Ctrl+Enter


  Hit the Find Next button


  Etc.

  


  (next: DEF5)


  DEF5


  



  In BOOK VIEW: One, Two, Three, ...


  In CODE VIEW: <p>One</p>, <p>Two</p>, <p>Three</p>, ...



  



  For these definition you can use the same approach as outlined in the previous one, with one catch:


  For One, Two, Three ... Twenty, Thirty, Forty, etc. it works great.


  For the In-Betweens not at all. For these I had to find the right Regular Expression.


  



  My solution, with Regular Expression mode checked:


  ... for the first twenty chapters: <p>[A-Z][a-z]*</p>


  ... for the next nine chapters: <p>[A-Z][a-z]*[-][a-z]*</p>


  ... for chapter Thirty: <p>[A-Z][a-z]*</p>


  ... for the next nine chapters: <p>[A-Z][a-z]*[-][a-z]*</p>


  ... for chapter Forty: <p>[A-Z][a-z]*</p>


  ... for the next nine chapters: <p>[A-Z][a-z]*[-][a-z]*</p>


  ... for chapter Fifty: <p>[A-Z][a-z]*</p>


  ... etc.


  



  Note: sounds rather complicated, but works well. You can easily change the search term in the Find & Replace Dialog, because sigil remembers the last 20.


  HOWEVER, if you find it too complicated, you can always fall back on the method of looking and finding in BOOK VIEW.


  



  Comment: This works for me, i found the solution for the catch by trial and error. As i said before, i still have minimal knowledge and experience with Regular Expressions.

  


  (next: DEF6)


  DEF6


  



  In BOOK VIEW: I, II, III, ...


  In CODE VIEW: <p>I</p>, <p>II</p>, <p>III</p>,



  



  In CODE VIEW


  Search in the Find & Replace Dialog for all occurrences of the chapter-names:


  Find what: <p>[A-Z]*</p>


  Regular Expression mode


  Hit the Find Next button


  Make a Chapter Break with Ctrl+Enter


  Hit the Find Next button


  Make a Chapter Break with Ctrl+Enter


  Etc.


  Note: this is the same method as for ONE, TWO, THREE, etc .!

  


  (next: DEF7)


  DEF7


  Images as chapter definition


  



  Some books use (small) images as a definition of the start of a (new) chapter. These books ask for a somewhat different approach, because after converting them in calibre to a TXT file, all images are gone.


  



  Open the original with Firefox: EPUBReader will show the images. So, you can easily determine where all the chapters start.


  In sigil change to CODE VIEW



  Go to FF


  Copy the beginning of the sentence under the image (select with cursor, Right Click, copy)


  Go to sigil


  Ctrl+F


  Paste behind Find what:


  Find Next will bring you to the start of the next chapter.


  Ctrl+H


  And so on for the rest of the chapters.



  



  How to add your own chapter-names? See method 3, at the end of THE FIRST DEF

  


  (next: DEF8)


  DEF8


  In BOOK VIEW: Description, Description, Description, ...


  In CODE VIEW: <p>Description</p>, <p>Description</p>, <p>Description</p>, ...


  



  This DEF you'll find in books with short stories or books with chapters that start with a description of or a hint at their content.


  To make chapters yo may follow the method of scrolling in BOOK VIEW and Ctrl+Enter.


  Another way would be the Copy & Paste method with the EPUBReader of Firefox (see DEF7, images). Better for your eyes!

  


  (next: Some Tips)


  SOME TIPS


  



  1. Watch your cursor! Make sure it is at the right place, before you let sigil do it's thing!



  



  2. Use the keyboard Shortcut Keys of sigil, as often as possible!


  



  3. Use the Firefox Add-on EPUBReader


  I make extensive use of the Firefox Add-on EPUBReader. With it you can open the original epub - if you have one - for a first view, the TXT file from calibre, the consecutive versions of the sigil-epub.


  With FF EPUBReader in the background you can easily test the results of all your editing in sigil.


  Note: Refresh does work. First activate the other TAB, then hit Refresh.


  



  2. The Case of the Broken Paragraphs


  Well, the name says it all: in some books i found split-sentences that should be in the same paragraph. A lot of them.


  Viewing and searching for them in BOOK VIEW was a no-no for me.


  So i tried finding them automatically in sigil. I had to use the Regular Expressions mode again (sigh). I found a way to do it.


  In CODE VIEW


  Find what: <p>[a-z]


  This finds all paragraphs beginning with a lowercase character.


  Select with your cursor from before the closing tag (</p>) to behind the open tag (<p>).


  Like this:


  <p>--------------------------------------------------------------------------x</p>



  <p>x--------------------------------------------------------------------------</p>


  (x stands for the start- and end-position of your cursor)


  Hit the space bar



  Done


  And then, the next 10, 20,30?


  Case solved and closed or are there any loose ends left?


  



  4. Look in "Look in:"


  In the Find & Replace Dialog you must always check the correct Search mode.


  BUT also what comes after Look in: 'Current File' or 'All HTML files'.


  Suppose you're searching for something and get the "The search term cannot be found." message.


  What will be correct only for the Current File, if that's in 'Look in:'.


  Change "Current File" into "All HTML files" and maybe you do find (more) occurrences of your search term.


  



  5.

